Template for Electronic Submission of Organic Letters
Word 98, version 1.1 (8-5-99)

It is encouraged that this template be used for submission of manuscripts to Organic Letters. The template contains much of the formatting information that is used in the journal. Use of the template will save time during production and expedite publication. However, you are not required to use the template to electronically submit a manuscript to Organic Letters.

The template is intended as a tool to assist you in the layout for the placement of your artwork. Using this template will also allow you to determine whether your letter is within the four-page limit. A sample formatted manuscript can be viewed at http://pubs.acs.org/OrgLet.


Copy the appropriate version of the template into the word processor where you normally prepare your manuscripts.


Type your manuscript into the copy of the template, typing over the text in the appropriate sections. If copying and pasting text into the template, see the paragraph at the end of this page for formatting instructions. Ensure all characters are correctly represented throughout the manuscript: for example, 1 (one) and l (ell), 0 (zero) and O (oh), x (ex) and ( (times sign). Use Symbol font for all Greek letters and math symbols.


To insert graphics within the text or as a figure, scheme, or table, create a new line and insert the graphic where desired. If your graphic is not visible, ensure that the Word Style is "Normal" with an automatic height adjustment (from the Format menu, choose Paragraph; under Line Spacing, choose Single) and not Word Style "TA_Main_Text", "VA_Figure_Caption", "VC_Scheme_Title", "VD_Table_Title", or "TC_Table_Body". Paste the graphics at the size they will be printed in the journal (follow ACS-1996 Style Sheet in ChemDraw for preparing your artwork). If the size of the artwork needs to be adjusted, re-size the artwork in your graphics program and re-paste the artwork into the template (maximum width for single-column artwork, 3.3 in. (8.5 cm); maximum width for double-column artwork, 7 in. (17.8 cm)). It is best to copy the actual ChemDraw artwork and paste it into Word rather than saving it as a file and pasting the file in. In addition, in ChemDraw, ensure that the Optimize for High-Resolution non-Postscript Printing Preference is ON.


Save the file with the graphics in place.


Proof a printout of the manuscript (from a 600 dpi or higher laser printer) to ensure that all parts of the manuscript are present and clearly legible.


After deleting these instructions, submit your manuscript by the method of your choice (see the latest Guidelines for Authors for details) (http://pubs.acs.org/OrgLet). If submitting electronically, your manuscript will be converted to a PDF file, which is a draft of the paper. This file is used strictly for peer review. Minor errors, such as footnotes appearing on the next page and odd spacing of text and paragraphs, will not be a problem. This paper will be reformatted as part of the editorial process; therefore, the appearance of footnote numbers does not need to be changed to match the journal style.

For more detailed information on the preparation of a manuscript for Organic Letters, see the latest version of the Guidelines for Authors (http://pubs.acs.org/OrgLet).

If you choose to copy and paste text into the template from another document, when you copy from your original document, be sure to include just the text (not the paragraph symbol) and paste it into the template. If the paragraph symbol is copied, the style of your original document overrides the template style. To change the style back to the template style, place your cursor anywhere in the pasted-in text and select the proper Word Style. In addition, the page size will need to be changed as follows:


Inches
Centimeters

Page size
8.5 ( 11
21.6 ( 27.9

Top margin
0.5
1.3

Bottom margin
0.66
1.7

Right margin
0.76
1.9

Left margin
0.76
1.9

Column width
3.33
8.5

Space between columns
0.33
0.8

Title (Word Style "BA_Title"). The title should accurately, clearly, and concisely reflect the emphasis and content of the paper. The title must be brief and grammatically correct

Author Names (Word Style "BB_Author_Name"). Include in the byline all those who have made substantial contributions to the work, even if the paper was actually written by only one person. Use first names, initials, and surnames (e.g., John R. Smith) or first initials, second names, and surnames (e.g., J. Robert Smith). Do not use only initials with surnames (e.g., J. R. Smith) because this causes indexing and retrieval difficulties and interferes with unique identification of an author. Do not include professional or official titles or academic degrees. At least one author must be designated with an asterisk as the author to whom correspondence should be addressed. To insert footnotes for author affiliations, do not use the Insert Footnote command. After the first footnote has been inserted in the text portion of the manuscript, in the footnote section of the paper, place your cursor before footnote 1 and click your Enter/Return key. In the new space created, type in the footnote for the author, giving it a symbol instead of a number. Insert the symbol after the author name to which this footnote pertains. 

Address (Word Style "BC_Author_Address"). The affiliation should be the institution where the work was conducted. If the present address of an author differs from that at which the work was done, give the current address in a footnote.

Email Address (Word Style "BI_Email_Address")

Received Date (will be automatically inserted after manuscript is accepted)

ABSTRACT

Insert your graphic entry in this space; the graphic should be inserted at publication size. To insert abstract graphic, delete this text and paste object inside the frame (do not delete the paragraph sign). The size of the artwork should be no larger than the size of this box. Text should be limited to the labeling of compounds, reaction arrows, and diagrams. Make liberal use of R groups and accepted abbreviations for functional groups.

Abstract Text (Word Style "BD_Abstract"). All Letters must be accompanied by an abstract containing no more than 75 words. The abstract should briefly state the reason for the work, the significant results, and the conclusions. A graphic entry for the abstract must be supplied with each Letter. This graphic and the abstract should provide the reader with a visual clue as to the paper’s content.

Text (Word Style "TA_Main_Text"). For full guidelines, please see the Guidelines for Authors.

Acknowledgment (Word Style "TD_Acknowledgments"). Generally the last paragraph of the paper is the place to acknowledge people, places, and financing (you may state grant numbers and sponsors here). Avoid use of phrases like "we (I or the authors) would like to thank" and "we (I or the authors) wish to thank", instead use "we (I or the authors) thank".
Supporting Information (Word Style "TE_Supporting_Information"). A brief statement in nonsentence format listing the contents of material placed here should be included at the end of the manuscript as a separate section titled Supporting Information Available. The contents of Supporting Information may include the following: (1) extensive tables, (2) graphs, (3) spectra, (4) detailed descriptions of experimental procedures, and (5) calculations.

Insert Figure here

Figures (Word Style "VA_Figure_Caption"). Each figure must have a caption that includes the figure number and a brief description, preferably one or two sentences. The caption should follow the format "Figure X. Figure caption.". All figures must be mentioned in the text consecutively and numbered with Arabic numerals. The caption should be understandable without reference to the text. It is preferable to place the keys to symbols used in the figure in the caption, not in the artwork. Ensure that the symbols and abbreviations in the caption agree with those in the figure itself and in the text. To insert the figure into the template, copy this section of the template (the bar, figure caption area, and thinbar) and paste it where you want your artwork to appear. Ensure that the figure is already sized appropriately, and paste it between the bar and figure caption, where shown. To insert multiple figures, one of the following methods can be used. (1) Copy this section and paste it where you want it to appear or (2) create this section by inserting Word Style "bar" (Return), pasting your figure into the template (Return), using Word Style "VA_Figure_Caption" to type in the figure caption (Return), and inserting Word Style "thinbar" (Return). For formatting double-column figures, see the instructions at the end of the template.

Schemes (Word Style "VC_Scheme_Title"). Groups of reactions that show action are called schemes. Schemes may have brief titles describing their contents. The title should follow the format "Scheme X. Scheme Title". All schemes must be mentioned in the text consecutively and numbered with Arabic numerals. Schemes may also have footnotes (use Word Style "FD_Scheme_Footnote"), inserted after the artwork. To insert the scheme into the template, be sure it is already sized appropriately and paste between the scheme title and the thinbar, where shown. If there are multiple schemes, either copy this section and paste where you want it to appear or create this section by inserting Word Style "bar" (Return), using Word Style "VC_Scheme_Title" to type in the scheme title (Return), pasting your scheme into the template at the appropriate size (Return), and inserting Word Style "thinbar" (Return). For formatting double-column schemes, see the instructions at the end of the template.

Insert Scheme here

Tables. Each table must have a brief (one phrase or sentence) title that describes its contents. The title should follow the format "Table X. Table Title" (Word Style "VD_Table_Title"). The title should be understandable without reference to the text. Put details in footnotes, not in the title (use Word Style "FE_Table_Footnote"). Define nonstandard abbreviations in footnotes.

Use tables (Word Style "TC_Table_Body") when the data cannot be presented clearly as narrative, when many precise numbers must be presented, or when more meaningful interrelationships can be conveyed by the tabular format. Do not use Word Style "TC_Table_Body" for tables containing artwork. Tables should supplement, not duplicate, text and figures. Tables should be simple and concise. It is preferable to use the Table Tool in your word-processing package, placing one entry per cell, to generate tables. If there are multiple tables, either copy this section and paste it where you want it to appear or create this section by inserting Word Style "bar" (Return), using Word Style "VD_Table_Title" to type in the table title (Return), creating the table using Word Style "TC_Table_Body" (Return), and inserting Word Style "thinbar" (Return). For formatting double-column tables, see the instructions at the end of the template.

Insert Table here

References (Word Style "TF_References_Section"). References appear as footnotes in the printed journal; please insert them using the Footnote command on the Insert menu. Position the insertion point where you want the reference mark to appear. From the Insert menu, select Footnote. Choose the OK button. Word will display a Footnote dialog box where you can type in the footnote. Detailed information on reference style can be found in The ACS Style Guide, 2nd ed.

To format double-column figures, schemes, and tables, use the following instructions:


Place the insertion point where you want to change the number of columns


From the Insert menu, choose Break


Under Sections, choose Continuous


Make sure the insertion point is in the new section. From the Format menu, choose Columns


In the Number of Columns box, type 1


Choose the OK button

Now your page is set up so you can have double-column figures, schemes, and tables. Follow the directions given above for figure, scheme, or table placement. Copy the example given below (including the top and bottom lines) and paste it into the template that is now single-column layout. Use the appropriate Word Style for whether it is a figure, scheme, or table, and then simply paste your graphic or table where you want it to appear. Alternately, insert Word Style "bar" (Return), use the appropriate Word Style for whether it is a figure, scheme, or table (Return), paste in the graphic or create table (Return), and then insert Word Style "thinbar" (Return). Be sure to add another section break after the thin bar and change it back to 2 columns with a spacing of 0.33 in. 

Table 1. Example of a Double-Column Table

Column 1
Column 2
Column 3
Column 4
Column 5
Column 6
Column 7
Column 8










� Journals: Author 1; Author 2. Journal Abbreviation year, volume, pages. For example: Smith, J. A.; Jones, B. R. Org. Lett. 1999, 1, xxxx.


Books with Editors: Author 1; Author 2. In Book Title; Editor 1, Editor 2, Eds.; Publisher: Place of Publication, year; volume, chapter, pages. For example: The ACS Style Guide, 2nd ed.; Dodd, J. S., Ed.; American Chemical Society: Washington, DC, 1997.


Books without Editors: Author 1; Author 2. Book Title; Publisher: Place of Publication, year; volume, chapter, pages. For example: Stothers, J. B. Carbon-13 NMR Spectroscopy; Academic: New York, 1972; Chapter 2.


U.S. Government Publications: Author 1; Author 2. Document Title; Government Publication Number; Publisher: Place of Publication, year; volume, chapter, pages. For example: National Handbook of Recommended Methods for Water Data Acquisition; Office of Water Data Coordination, U.S. Geological Survey: Reston, VA, 1977; Chapter 5.


Technical Reports: Author 1; Author 2. Title. Technical Report Number; Publisher: Place of Publication, year; volume, chapter, pages. For example: Schneider, A. B. Technical Report No. 1234-56, 1985; ABC Company, New York.


Patents: Author. Patent number, year. (Patent number with reference to country granting the patent.) For example: Lyle, F. R. U.S. Patent 5 973 257, 1985; Chem. Abstr. 1985, 65, 2870.


Thesis: Author. Level of Thesis, Degree-Granting University, Location of University, date. For example: Fleissner, W. Ph.D. Dissertation, University of Tennessee, Knoxville, TN, 1984.


Series: Author 1; Author 2. In Title; Editor 1, Editor 2, Eds.; Series Title and Number; Publisher: Place of Publication, year; volume, pages. For example: Nonlinear Optical Properties of Organic Polymeric Materials; Williams, D. J., Ed.; ACS Symposium Series 233; American Chemical Society: Washington, DC, 1983.


Citation to Meetings: Author 1; Author 2. Title of Presentation. Published Title of Collected Work, Proceedings of the Name of the Meeting, Location of the Meeting, Date of the Meeting; Editor 1, Editor 2, Eds.; Publisher: Place of Publication, year; abstract number, pages. For example: Baisden, P. A. Abstracts of Papers, 188th National Meeting of the American Chemical Society, Philadelphia, PA; American Chemical Society: Washington, DC, 1984; NUCL 9.








